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DISCLAIMERS 

The information in this publication remains the property of ViewCast Corporation. Users may 
not use, reproduce, or disclose this information without the implied consent and written 
approval of the company.  

ViewCast  Corporation makes no representations or warranties with respect to the contents or 
use of this manual and specifically disclaims any express or implied warranties of 
merchantability or fitness for any particular purpose. Further, ViewCast Corporation reserves 
the right to revise this publication to make enhancements in the products described in this 
manual, at any time, without obligation to notify any person or entity of such revisions or 
changes. In no event will ViewCast Corporation be liable for direct, indirect, special, incidental, 
or consequential damages arising out of the use or inability to use the product or 
documentation, even if advised of the possibility of such damages. 

WARRANTIES 

For complete warranty details, refer to the specific warranty included with each product. 
General warranty information includes the following: 

Reseller Pass Through of 
Standard Limited Warranties. 

Resellers pass the ViewCast standard limited warranties 
for the products through to the customer without 
modification. Any modification of any product voids the 
ViewCast warranties or any other existing or available 
warranty. 
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About This Guide 

This ViewCast Niagara® SCX Guide provides set up and configuration information for anyone 
who uses or administers the Niagara SCX client software. Users should have a basic technical 
understanding of their media-encoding environment and some basic experience with streaming 
media principles and practices. Users should also understand and use Microsoft Windows. 

Conventions for This Guide 

This guide uses the document conventions specified in Table 1 to help you identify different 
types of information. 

Table 1. Guide Conventions 

Convention Description Example 

NOTE:  
Provides supplemental 
information. 

NOTE: The prompt 
may not display 
ƛŦ Χ 

IMPORTANT! 
Provides important data that 
does affect how the system or 
software responds. 

IMPORTANT! You must install 
Niagara SCX prior to 
configuring SCX optionsΧ 

  WARNING !  

Provides information to ensure 
that you avoid potential injury, 
death, or permanent system 
damage. 

  WARNING !  Do not 
touch exposed wires. 

 

 

  

  

 

Provides information to help you 
avoid possible damage to 
hardware or a system crash 
(without data loss). 

 Use case 
sensitive 
commands to keep 
ŦǊƻƳ ŘŜǎǘǊƻȅƛƴƎΧ 
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Chapter 1: Welcome to Niagara SCX 

The exclusive ViewCast Niagara SCX streaming media management software provides an 
optimal method for managing live video broadcasting over the Internet and to mobile devices. It 
allows you to set up, monitor, and control multiple, remote, or distributed Niagara SCX 
streaming encoder systems positioned throughout your enterprise or anywhere in the world ς 
all from your desktop. Niagara SCX is included on all ViewCast encoding appliances. 

This manual focuses on the Niagara SCX client interface. For information on the Web interface, 
see the specific product manual or the product quick start guide. 

System Features 

¶ Software version 6 is pre-installed and available only on ViewCast encoding appliances 

¶ Full control of encoding parameters 

ñ Video and audio input selection ñ 9ƴŎƻŘŜǊ ǇǊƻŬƭŜκǘŀǊƎŜǘ ŀǳŘƛŜƴŎŜ 

ñ Video resolution and format ñ Stream destination and port 

ñ Video and audio attributes  

¶ Input/output preview 

¶ Vectorscope/waveform display for end-to-end color accuracy 

¶ Encoder statistics monitoring: 

ñ Frame rate, bit rate 

ñ CPU load 

ñ Audio level 

¶ Application integration via XML 

¶ Real-time capture and compression from a live video source 

¶ Support for NTSC, PAL, wide screen, CIF, QCIF, SECAM, and all popular resolutions in 
addition to custom user-defined picture dimensions 

¶ Support for all widely used bit rates, from 16 kb/s to 4 Mb/s ҌΧ 

You can instantly view the status of all of your networked encoders and active encoder sessions, 
as well as control and monitor each individual stream. ViewCast delivers two versions of Niagara 
SCX ς Niagara SCX Standard and Niagara SCX Pro. 

The major difference between the two versions is that Niagara SCX Pro contains MPEG-4 
encoding technology and Niagara SCX Standard does not. Some encoding appliances also 
provide the ability to stream Flash. Its basis remains anchored on an international standard that 
is a popular format for streaming Internet video. Chapter 10 of this publication more fully 
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explains the MPEG-4 features, available only in Niagara SCX Pro. The MPEG-4 implementation in 
SCX follows the guidelines of ISO/IEC 14496-2 specifications that make the system compatible 
with the most popular third-party MPEG-4 implementations that use the MPEG-4, Simple 
Profile, and/or Advanced Simple Profile. 

Appendix A: An Introduction to Streaming Media provides a complete overview on streaming 
audio and video over an IP network. Access http://www.viewcast.com/support_streaming.asp 
for more information about streaming media. 
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Chapter 2: Quick Start 

A quick start for Niagara SCX includes configuring the environment then starting and using 
Niagara SCX. 

Set Niagara SCX Environment 

Table 2. Set Up the Niagara SCX Environment 

Step Action 

1.  Open Niagara SCX Explorer on the ViewCast encoding appliance you plan to 
control. You may use remote desktop to connect to the encoding appliance. 

2.  To connect to the Niagara SCX Client, double-click the Niagara SCX shortcut from 
the encoding appliance desktop. 

Figure 1. Niagara SCX Desktop Shortcut 

 

3.  Ensure the server and all optionally connected remote workstations have visibility 
to each other. 

NOTE: The default user name is Niagara and the password is 
password. 

Begin Encoding 
Table 3. Encoding Steps 

Step Action 

1.  Start Niagara SCX or verify the service started. 

2.  Insert the desired encoder type you wish to run on the server or on the toolbar, 
click Insert then Encoder. The system displays the New Encoder dialog box 

 Choose any of the following: 

 ¶ Flash Video 

¶ RealProducer 

¶ Windows Media Encoder 

¶ MPEG-4 (only if you have a 
Niagara SCX Pro license) 

¶ AVI Capture 
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Step Action 

3.  Enter a name to identify the encoder and press Enter. The system displays the 
name in the Codec Name field in the General Properties area of the Auto/Name 
tab. 

NOTE: Encoder types vary on each appliance. 

4.  Repeat steps 4 and 5 for each encoder. You can start and stop the encoders on 
an as-needed basis. 

5.  Click the Video and Audio input source for the encoder from the drop-down box 
on the Input tab. 

NOTE: This field may also include a file you need to convert to a streaming 
format. 

6.  Configure the video and audio settings, if needed, on the Video Settings and 
Audio Settings tab. 

7.  Click either Enable Streaming to begin streaming or Save to File on the Output 
tab. 

NOTE: RealProducer has two output settings. Determine, with the first 
output, if the output exists as a live broadcast you plan to save in a file 
for future use. The second Output tab establishes the target audience. 
 

Windows Media encoder has only one output tab. It contains both the 
target audience and information for saving the video to a file. 

8.  Enter the author and copyright information on the Author Info tab under the 
streaming options for the encoder if necessary. 

Ensure Enable SimulStream is checked on the Filters tab. 

9.  Click the View tab under streaming options to preview the video. 

NOTE: Steps 9 and 10 are optional. 

10.  Click Start on the Operations tab to begin encoding. 

NOTE: Click Streaming Options to view statistics for the encoding session. 
Select the various tabs to see data about the encoding session. 
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Chapter 3: Niagara SCX and Explorer 
Basics 

This chapter explores the basics of the SCX service and application. It includes the following 
topics: 

¶ Niagara SCX Window Design 

ñ Toolbar 

ñ Menu bar 

ñ Creating a new Niagara SCX view 

¶ Starting and stopping the Niagara SCX service 

Niagara SCX Window Design 

The Niagara SCX  functions like Windows Explorer. The left panel of the Niagara SCX Encoder 
Explorer window (Figure 2) displays your Niagara SCX Encoder Manager and associated 
encoders. When you select an encoder, its corresponding properties display on the right. 

Figure 2. Niagara SCX Encoder Explorer 

 

Toolbar 

The Niagara SCX toolbar (Figure 3) contains the most frequently used commands in the 
application. This guide details and explains each command in later sections. On the application, 
click each of the buttons to learn more how to use them. The toolbar also lists the same 
commands on the Niagara SCX menu bar.  
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Figure 3. Niagara SCX Explorer Toolbar 

 

Table 4. Toolbar Elements 

Element Description 

 
New 

¶ Create a new Niagara SCX Encoder Manager connection. 

¶ Group and save different SCX views for monitoring the status of 
multiple encoders. 

 
Open 

Connect to and use existing Niagara SCX encoders. 

 
Save 

¶ Save any SCX encoder combinations you put in Niagara SCX to the 
existing location using the current name. 

¶ Save many different encoder combinations with unique names. 

 
Connect 

The system opens a prompt for you to enter the computer name or IP 
address and connect to a system running Niagara SCX. 

 
Encoder 

¶ Add a new or different encoder. Options may include: 

ñ AVI 

ñ Flash 

ñ RealProducer 

ñ Windows Media 

ñ MPEG-4 (for Niagara SCX Pro only) 

 
Delete 

Delete an encoder connection from Niagara SCX. 

 
Help 

Copy of the Niagara SCX User Guide 
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Menu Bar 

The Menu bar contains some commands not available on the Niagara SCX toolbar. 

File 

Figure 4. File Menu Commands 

 
Table 5. Menu Bar File Commands 

Command Description 

New ¶ Create a new Niagara SCX Encoder Manager connection. 

¶ Group and save different SCX views for monitoring the status of 
multiple encoders. 

Open Connect to and use existing Niagara SCX encoders. This command 
displays the Open window (Figure 5). 

Figure 5. Open 

 

¶ Click the file you want to open; click Open. The system displays 
the Niagara SCX Encoder Explorer window (Figure 6). 

Figure 6. Niagara SCX Encoder Explorer  

 
 

NOTE: The previously saved configuration automatically opens when 
Niagara SCX launches. 

Save ¶ Save any SCX encoder combinations you put in Niagara SCX to the 
existing location using the current name. 

¶ Save many different encoder combinations with unique names. 
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Command Description 

Save As Save changes to an existing encoder and apply a different name. 

Recent 
File 

The system stores and displays your last four saved encoders thereby 
allowing you to load a Niagara SCX encoder quickly. 

Exit Exits Niagara SCX. 

Edit Menu 

Figure 7. Edit Menu Commands 

 
Table 6. Menu Bar Edit Commands 

Command Description 

Delete Delete an encoder connection from Niagara SCX. 

Rename Rename the encoder connection. 

ReConnect ¶ Reconnect to Niagara SCX. This command is useful when you stop 
the Niagara SCX service and start it again while running Niagara SCX 
Explorer. 

NOTE: When you launch a Niagara SCX Explorer, it may appear 
unresponsive if Niagara SCX becomes unavailable for any reason. 
 

Wait a minute for the application to become available and the system to 
flag the unresponsive Niagara SCX. 
 

You can also delete, rename, or reconnect to Niagara SCX by clicking the 
specific item, right-click, and select Delete, Rename, or Reconnect. 

View Menu 

Figure 8. View Menu Commands  

 

Table 7. Menu Bar View Commands 

Command Description 
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Command Description 

Toolbar ¶ View the toolbar on the SCX window. You must check (click) 
this option. 

Status Bar ¶ View the status bar on the SCX window. You must check (click) 
this option. 

Insert Menu 

Figure 9. Insert Menu Commands  

 

Table 8. Menu Bar Insert Commands 

Command Description 

Niagara SCX 
Encoder Manager 

Select encoder system you wish to view. 

Encoder Insert a new encoder. 
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Create a New Niagara SCX Explorer 
Connection 

Niagara SCX Explorer views allow you to save and view a list of encoder systems. You save time 
by recalling a saved view instead of manually connecting to each individual Niagara SCX. Views 
act like bookmarks. They do not contain any in-depth information about your managers (such as 
the types of encoders you connected). 

Table 9. Create New Niagara SCX Explorer Connection 

Step Action 

1.  

 

Click File; then New. The system displays the Niagara SCX Explorer window 
(Figure 10) with no Niagara SCX systems listed. 

Figure 10. Niagara SCX Explorer 

 

2.  Click Insert; then  

3.  Click Niagara SCX Encoder Manager. 

4.  Confirm the computer name listed or use Browse to locate your computer 
name when the Connect To Server window (Figure 11) displays. 

Figure 11. Connect to Server 

 

5.  Click OK. The system displays a window (Figure 12) with the Niagara SCX 
Encoder Manager you inserted. 
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Step Action 

Figure 12. Niagara SCX Encoder Insert Selection 

 

6.  To insert encoders, select Insert ü Encoder... The system displays the New 
Encoder dialog box. 

7.  Select from the drop-down menu of available encoders and click OK. The 
system displays the encoder with the default name New Encoder highlighted. 
The tab changes to Auto/Name. 

8.  Rename the encoder for easy identification (Figure 13) and press Enter. The 
system displays the new name in the Codec Name field on the Auto/Name tab. 

Figure 13. Name Encoder 

 

9.  Repeat the process to insert multiple encoders. 

10.  When you finish inserting all the encoders, select File ü Save As and enter a file 
name for the new combination of Niagara SCX and encoders. 

11.  Click Save. 

Sample Encoder Views 

Figure 14 provides a sample of the Manual.cex view combination containing one Niagara SCX 
with six complete encoders and one encoder being added. 

Figure 14. Sample Encoder View (Six Encoders+Add Encoder) 
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Insert a New Encoder 

After adding Niagara SCX Encoder Manager, you must take the next step and insert any new 
encoder(s) that you want the specific Niagara SCX to control. Start this procedure from the 
Niagara SCX Encoder Explorer window showing the encoder system you wish to add encoders. 

Table 10. Configure Connections 

Step Action 

1.  Go to the Insert menu and select Encoder. The system displays the New 
Encoder dialog box (Figure 15). 

Figure 15. New Encoder 

 

NOTE: You can alternately insert an encoder by clicking on the 
Encoder toolbar element; or clicking the encoder, right-clicking, 
and clicking Insert a New Encoder. 

2.  Select the encoder type you want to add from the Encoder drop-down list. Click 
OK.  

3.  Click OK to save the encoder you want to connect. If you do not want to save 
the encoder, click Cancel.  

The system displays the new encoder with the default name New Encoder 
highlighted. The tab changes to Auto/Name. 

Figure 16. New Encoder Display 

 

4.  Type a name for the encoder such as Encoder 1 or Main Auditorium. 

5.  Press Enter to save the name change. 

6.  Repeat the above steps for any additional encoders installed on this sever. 
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Encoder Menu 

Figure 17. Encoder Menu Commands 

 

Table 11. Menu Bar Encoder Commands 

Command Description 

Encoder Start Start an encoder. 

Encoder Stop Stop an encoder. 

Encoder Reset Reset an encoder. 

Start an Encoder 

1. Click on the encoder in the left side of the Niagara SCX Encoder Explorer window.  

2. Click the Encoder menu. 

3. Click Start. The system starts the encoder. 

NOTE: You can also start an encoder by selecting the encoder, right-clicking, and selecting 
Start Encoder. 

Stop an Encoder 

1. Click on the encoder in the left side of the Niagara SCX Encoder Explorer window.  

2. Click the Encoder menu. 

3. Click Stop. The system stops the encoder. 

NOTE: You can also stop an encoder by clicking the right-mouse button and selecting Stop 
Encoder while you have the specific item selected. 

Reset an Encoder 

Resetting an encoder is equivalent to stopping and starting the encoder. 

1. Click on the encoder in the left side of the Niagara SCX Encoder Explorer window. 
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2. Click the Encoder menu. 

3. Click Reset. The system resets the encoder. 

NOTE: You can also restart an encoder by clicking the right-mouse button and selecting 
Restart Encoder while you have the specific item selected. 

Help Menu 

Table 12. Menu Bar Help Commands 

Command Description 

Help Contents View the contents in the help file. 

About Niagara 
Encoder 
Explorer 

View information about the installed Niagara SCX software 
(including version release). 

Stop the Niagara SCX Explorer 

Once you configure all the necessary settings, you may exit the Niagara SCX Explorer application 

by selecting File ü Exit. You may also click the exit icon (  ) in the upper right of the 
window. 
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Chapter 4: Windows Media Options and 
Settings 

Table 13 and Table 14 explain the encoder and streaming options tabs available when using 
Windows Media as the encoding option. 

Windows Media Encoder Tabs 

Table 13 describes the configuration options available on the tabs accessible from the Windows 
Media Encoder windows. 

Table 13. Windows Media Encoder Tabs 

Tab Description 

Auto/Name ¶ Set the name for the encoder and the option to Automatically Start 
Device at Service Startup (Error! Reference source not found.). 

¶ The encoder starts when the Niagara SCX service starts if you click this 
auto start option. 

¶ The Located On field provides the name of the machine where the 
encoder resides. 

Figure 18. Windows Media Properties 

 
Input Set the input sources to use for Live or File encoding and Transcoding 

(Figure 19). 
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Tab Description 

Figure 19. Windows Media Input Sources 

 
Live Encoding 1. Click the Live radio button. 

2. Click the video capture device in the Video field. 

3. Click the audio device in the Audio field for live encoding. 

The system lists all known video and audio devices in the drop-down 
menus. 

File Encoding 1. Click the File Conversion/File Transcode radio button to encode a 
previously recorded file (such as .avi or .wav files) into streaming 
format. 

2. Choose from the Input File dropdown menu for a file name to insert. 

Remember the file name applies to the encoder system and not the system 
currently running SCX Explorer. 

IMPORTANT! When Niagara SCX and SCX Explorer reside on different computers, always 
start your browse for files at My Network Places. Then work down or enter the entire 
file pathname beginning with the system name (such as \ \ fileserver\c\videos). 
 
If you simply enter a file name, you may inadvertently browse your local computer 
when the media file resides on the remote computer. 

Video Settings Control the capture properties for the selected video device. (Figure 20): 

¶ The Input field lists all input connectors available for the capture 
device. 

¶ The Signal field lists the various video standards the capture device 
supports. 

¶ You can adjust capture properties such as proportion, video size, and 
width/height  using the provided fields. 

¶ Adjust additional capture properties of brightness, contrast, saturation, 
and hue individually for each input source using the sliding bars. 

¶ When making such adjustments, verify your adjustments apply to the 
selected input. Otherwise, your adjustments apply to all the input 
sources listed. 

¶ The capture properties remain available regardless of whether the 
encoder starts or remains idle. 
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Tab Description 

Figure 20. Windows Media Video Settings 

 
Gamma Correction Adjust the gamma of the incoming video : 

¶ Gamma refers to the response curve of video cameras/CRTs. 

¶ When you capture video with a camera, the camera response remains 
deliberately nonlinear ς it boosts low lumen values and compresses 
high lumen values ς based on two reasons: 
(1) It increases the effective bandwidth in the low lumen range, where 
you need it, at the expense of the high lumen range, where you need it 
less. 
(2) It matches the response characteristics of TV sets and monitors. 

¶ The calibration specified in video standards matches the requirements 
of cameras and TV sets in broadcast use. 

ñ However, this calibration usually does not match the needs of 
computer-based applications or the response curves of computer 
monitors. 

ñ Therefore, you often need a correction inverse to the original bias 
and you may want to tune for the characteristics of a particular 
monitor. 

¶ When you disable the gamma correction filters: 

ñ Set the gamma correction value to exactly 1.00. 

ñ The software-based gamma filter works in pass-through mode with 
no effect on the video and no processing bandwidth use. 

ñ Uncheck the Gamma checkbox. 

¶ When you enable gamma correction, the text box and graphic show the 
factor applied. 

¶ If you run preview video while adjusting the filter, you see your 
adjustment effects interactively. 

¶ You can use one of three methods to adjust the gamma correction 
value: 
(1) Directly enter text in the numeric text box. 
(2) Click [+] and [-]. 
(3) Select Signal field (NTSC, PAL, or SECAM) from the list of options. 
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Tab Description 

NOTE: The value represents the inverses of the gamma bias you applied at the video 
source per the video standard so the resulting video becomes gamma-neutral. 

 ¶ To enable: 

ñ Check the enable field. 

ñ When the setting equals 1.00, you make the response 
characteristics and the bandwidth identical to the original picture. 

¶ Gamma correction applies to all filters and all output pins on each 
device. 

¶ You can have different gamma corrections for different physical 
devices. 

Tuning Utilities ¶ Access the Tuning Utilities for a selected card. 

¶ Refer to Chapter 11: Tuning Utilities for additional diagnostics 
information. 

Restore Defaults ¶ Restore the system to the factory defaults. 

Audio Settings ¶ Indicate the input source for the selected audio devices. 

¶ Makes left and right volume levels available for adjustments if the 
audio capture device supports them. 

¶ Mute audio 

¶ Use audio components 

¶ Fields remain available whether the device runs or remains idle (Figure 
21). 

Figure 21. Windows Media Audio Settings 

 
Output ¶ Indicate if you want to pull or push the stream and provide a port 

number (Figure 22). 

¶ Server address 

¶ Stream name 

¶ Click server type 

¶ Username 

¶ Password 

 ¶ Click Save to file if you want to save the content to a file. 
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Tab Description 

¶ Remember the encoder system references the file name and not the 
system running SCX Explorer. 

¶ When Niagara SCX and SCX Explorer reside on different computers, 
always start to browse for files at My Network Places and work down 
or enter entire file pathname starting with the system name. 

¶ If you simply enter a file name, you may inadvertently browse your 
local computer when the media file resides on the remote computer. 

¶ Create unique file. 

Figure 22. Windows Media Output Settings 

 
Filters ¶ Use (optionally) to enable SimulStream and deinterlacing (Figure 23). 

¶ Refer to Filters on page 76 for more information about this topic. 

Figure 23. Windows Media Filters 

 

NOTE: Refer to Chapter 11: Tuning Utilities for more diagnostics information. 

Profile Settings Provide options for the Profile Settings, such as Capture Profile, and 
settings for Digital Rights Management (Figure 24). 
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Tab Description 

Figure 24. Windows Media Profile Settings 

 

NOTE: The system allows Enable DRM check box to give DRM protection for this encoder 
if you imported a DRM Profile (Chapter 6). 

Video Cropping ¶ Set the size and aspect ratio of chosen video output. 

¶ When you enable cropping, the system automatically switches the 
video size to FULL and the cropping measurements default to the FULL 
size. 

¶ From these settings, you can set a custom cropping size (Figure 25). 

Figure 25. Windows Media Video Cropping Settings 

 
Watermarking ¶ Place a watermarked graphic over your video output. 

¶ Adjust the color balance, size, and opacity of the graphic. 

¶ You can only watermark a 24-bit bmp. 

¶ The system does not accept any other image formats (Figure 26). 




















































































































































